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Welcome 

This manual highlights the use of DSI’s FinePointe™ Cough Site for Mouse, Rat, and Guinea Pig studies. The purpose 
of this document is to provide an overview of the methods used to measure coughs, as well as to describe the 
process required to configure the FinePointe™ Whole Body Plethysmography system and FinePointe™ software for 
successful measurements. 

Introduction 

The FinePointe™ System provides support for research that requires counting of coughs and comparison of these 
cough counts under varying conditions.  Traditionally, this type of experiment was performed by trying a technician 
to watch and listen to a single guinea pig and subjectively make a determination one each expelling event if it is a 
cough, sneeze or some other event. These researchers have usually only been interested in coughs, so they would 
increment a counter on each cough event.  They would monitor the subject for a couple fixed intervals of time 
following a cough stimulation challenge. 

Due to the subjective nature of this method of evaluating cough, it is known that the results are determined to 
some degree by the technician.  Training of the technician is critical, and some suggest that it is best of have the 
same technician evaluating the data for all the subjects within a study.  Certainly, if only one technician can 
perform the cough counting, this will severely limit the throughput and so the number of experimental conditions 
that can be evaluated. 

The FinePointe™ system provide analysis which automates this counting and introduces much needed objectivity.  
The approach that FinePointe™ uses to count coughs is not the same.  That is, FinePointe™ employs an 
Unrestrained Whole Body chamber to measure box flow data to assess coughs, rather than visual observation and 
listening for the characteristic sounds.  This box flow signal is a function of two components:  the change of 
pressure within the lung, and temperature and humidity conditioning of the air passing in and out of the animal.  

FinePointe™ supports cough detection on guinea pigs and mice.  Each uses a distinctly different algorithm.  Both 
algorithms use a very similar approach to detecting an expelling event, but they differ in how they categorize that 
event as a cough or something else. 

The guinea pig categorization was developed using a fuzzy logic algorithm by comparing a great deal of manually 
scored data with parameters derived from each event.  Categorization for rat uses the same logic as the guinea pig 
algorithm. Since it is very difficult for a technician to assess a cough based on sound, the mouse categorization 
simply codes the shape of the event as a number.  The meanings of reported parameters are not the same for each 
species.   

In this document, the background of the application, which describes what a cough is, and a typical cough protocol 
is described.  Following that, the apparatus is briefly described which and covers some special calibration options 
which may need to be set.  Finally, each algorithm for each species is described separately. 
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The Cough and the Whole Body Plethysmograph 

A cough begins with an inspiration of air into the lung.  Next, the air is compressed against a closed glottis 
(compressive phase), and then finally released through the glottis (expulsive phase).   

The unrestrained whole body plethysmograph measures air expansions and contractions that take place within the 
chamber.  The animal is not restrained or instrumented in any way, and since the animal’s breathing is responsible 
for most of the air expansions and contractions within the chamber, using Boyle’s law and some assumptions 
about the lung mechanics, the animal’s ventilation can be inferred. 

The inspiration of air prior to a cough is not necessarily any different from a normal inspiration, though it can be 
faster or deeper than it typically is during a normal breath.  When air is inspired into the lungs, the air is 
transferred from outside the lung to inside the lung, and in doing so, it is heated and humidified (conditioned).  In 
addition, in order to force the air into the lung, the diaphragm causes a slight negative pressure in the lung.  So 
during inspiration, the heating, humidification, and the slight negative airway pressure cause the air drawn into the 
lung to expand.  In normal healthy breathing, the air expands by roughly 10%. The additional expanded volume is 
forced out of the plethysmograph through the pneumotach located in the side of the plethysmograph.  The rate of 
flow out of or into the plethysmograph is measured by a pressure transducer (calibrated as a flow1) and presented 
to the user as Box Flow. low.  Again, this box flow is typically about 10% of the airflow that the animal is actually 
breathing. 

During a normal expiration, the process is a little more complex but similar to the reverse of inspiration.  The 
animal recovers some of the heat added to the air it breathed in, but not.  Also, if the animal is suffering from 
airway constriction, a possible compressive pressure may be exerted in the lung in order to force the air out.  Both 
the reclaiming of heat and humidity in the expired air and the possible compression cause air to be drawn back 
into the plethysmograph.  And once again, the flow of air drawn into the plethysmograph through the pneumotach 
is measured. 

 

 
1 The pressure transducer can be calibrated as a flow since the design of the pneumotach ensures a linear relationship 
between the pressure across the pneumotach and the flow rate through the pneumotach. 
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Figure 1. Box flow and box volume during normal respiration.  Box flows above the thick zero line occur when the 
animal is expiring. The dashed line shows where the animal is transitioning from expiration to inspiration of the 
next breath. 
 

To illustrate this, Figure 1 shows the relationships between box flow and box volume (the integrated form of box 
flow).  The dashed line indicates when the lung volume is at FRC, at the end of expiration. The box volume peaks 
occur when the animal switches from inspiration to expiration. 

The compressive phase of a cough occurs immediately after the inspiration of air into the lung.  The glottis is 
blocked, and the diaphragm compresses the air in the lungs against the glottis.  The compressed air in the lung 
causes air to be drawn into the chamber, even though no air flows in or out of the animal.   
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Figure 2.  This shows a close-up look at a cough, its phases, and how they are reflected in box flow, box volume, 
and airway pressure. The red portion of the trace shows the Compressive Phase.  The green portion shows the 
Expulsive Phase. 
 

In Figure 2 the compressive phase is shown in red.  Immediately following the inspiration phase, there is a massive 
buildup in pressure shown in red on the Airway Pressure chart.   That build up in pressure forces the air in the 
lungs to compress and air is drawn into the chamber as shown on the box flow and box volume signals (in red). 

At some point, the animal opens the closed glottis and the pressure in the lung is released in the following 
expulsive phase of the cough.  As air rushes past the glottis, it produces a characteristic hoarse cough sound.  
Pressure is relieved and returns to normal levels at the end of the expulsive phase. 
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In Figure 2 illustrates the expulsive phase in green.  Notice that although air is rushing out of the animal in this 
phase, the box flow signal moves seem to show air flow in the inspiratory direction.  This is due to the expansion of 
the compressed air overwhelming any affects due to conditioning.  In fact, if you were to remove the compressive 
and expulsive phases from the box flow and box volume signals, the result would appear to be something like a 
sigh.   
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Figure 3. These graphs illustrate the relationship between box flow, box volume, and airway pressure during 
normal breathing and a cough. The Box Flow shows the flow in and out of the plethysmograph.  Negative flows 
mean air is leaving the plethysmograph, and positive flows are air entering the plethysmograph.  During 
inspiration, air leaves the plethysmograph (negative flow). 
 

Figure 3 shows a cough event surrounded by normal breaths.  This illustrates the magnitude differences between 
the various signals to give you some idea how a cough might relate to a normal breath. 
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Configuring Apparatus for Cough 

 

Note:  If you are utilizing the FinePointe™ WBP controller or the QT 1000, then no special configuration is 
necessary.   

However, if you are using a MAX II with MAX2270 or MAX2275 preamplifiers, then you will need to set an option in 
the hardware configuration so that the box flow will be calibrated with a lower sensitivity.  This is necessary since 
the flow box rates during the compressive and expulsive phases will saturate a normal calibration. 

The following section describes how you create a hardware configuration for the MAX II preamplifiers. 

In FinePointe™, the apparatus is configured by using the FinePointe™ Control panel to create or edit a hardware 
configuration.  Begin by running the FinePointe™ Control Panel.  You will need Windows administrator account 
credentials to log in. 

Once you have logged in, click the Hardware Configuration button from the main page. 

 

Figure 4.  The Hardware Configuration button on the FinePointe™ Control Panel main page. 
 

Clicking this button will bring you to the hardware configurations page. 
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Figure 5.  The Hardware Configuration page in the FinePointe™ Control panel.  This image shows that there is 
already one hardware configuration (named "Cough Station"). 
 

From the hardware configurations page, you can either create a new hardware configuration, or you can edit an 
existing one.  To create a new one, click the New Configuration button.  To edit an existing one, choose the 
configuration you want to edit and click on the amber button between the blue and the red buttons.   

When you create a new configuration, FinePointe™ walks you through a wizard to help you set it up.  Editing an 
existing configuration is the same process except the wizard is populated with the selections you saved previously. 

The first page of the wizard asks you to name the configuration and select the hardware that you will use with this 
configuration.  The name is the name you will see in FinePointe™ Review when you want to acquire data or 
calibrate. 

 

 

Figure 6.  The first page of the Hardware Configuration Wizard. 
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The name must be unique from all the other configurations you have, and if you are editing an existing one, you 
can assume the name does not need to be changed.  Uncheck the hardware you are not using and make sure the 
hardware you want to use is checked.  In this case you should have one Max II instrument checked. Click Next. 

 

Figure 7. The second page of the Hardware Configuration wizard.  On this page, you define the sites you have.  A 
site is apparatus for acquiring data for a single subject. 
 

Next you have to define the sites you have.  A site is apparatus for acquiring data for a single subject.  Here you 
should select the Chamber Type as Legacy WBP Site and the species you will run with.  Shown in Figure 7 Guinea 
Pig is selected.  Next you need to click the + button once for each site.   

 

Figure 8.  The second page of the Hardware Configuration wizard after 4 guinea pig sites have been added. 
 

Click Next. 
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Figure 9.  The final page of the Hardware Configuration wizard.  This page allows you to connect the hardware 
you selected on the first page to the sites you declared on the second page. 
On the final page of the Hardware Configuration wizard, you need to connect the inputs of the site to the 
instrument preamplifiers that the site is physically connected to.   

 

This page is divided into two parts.  The upper part shows the sites you defined on the second page of the wizard, 
and the lower part shows the instruments you selected on the first page of the wizard.  There is one tab on the 
upper side for each site, and one tab on the lower side for each instrument.    You will need to make sure each site 
is connected up properly to the instruments on the lower part of the page.   

 

For each site, you will need to connect the Box Flow signal to one of the leads on an instrument.  The other signals 
should be left disconnected.  Also, you must make sure that the Calibrate Box Flow for Cough button is checked.  
This checkbox tells FinePointe™ to reduce the sensitivity of the calibration so that it is suitable for the cough 
detection. 

On the first site, you will want to connect the nebulizer and drier digital control lines to outputs on the Max II.  This 
is necessary so that the task sequence on the first site can control the nebulizer to deliver the irritant. 
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Figure 10.  Typical connections for the first site of a hardware configuration. 
 

The second site (and each site after) would look similar to Figure 11 except that the Box Flow input would be 
connected to its own lead, and there is no need to connect the Nebulizer and Drier output lines. 

http://www.datasci.com/


   
 

Page 13 
Cough Site Application Manual • Publication 0011580-001 REV 04 • www.datasci.com  ©2023 Data Sciences International 
 

 

Figure 11.  Setup for the second site, and subsequent sites. 
 

Next you should click on the Preamp Configuration button so that you can tell FinePointe™ what kind of 
preamplifiers you are using.  This setting helps FinePointe™ configure the calibration wizard to provide instructions 
explicitly defined for your hardware. 
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Figure 12.  Preamp Configuration form.  Pictured here, lead 1, 2, 3 and 4 are configured to have the MAX2275 
preamplifier modules. 
 

Click Finish. 

Cough Study 

In FinePointe™ a cough study allows you to acquire data from multiple subjects and summarize that data in subject 
groups as you choose.  Cough data collection sequences all follow the following procedure: 

1. Acclimate the subject for a period of time.  This allows the subject to settle down in the WBP 
plethysmograph.  During this time, data is acquired and stored, but not used for reporting. 

2. Start to nebulize the irritant (typically citric acid or capsaicin) 
3. Acquire data during the nebulization of the irritant, typically 20 mins.  A measurement interval is 

automatically placed for this entire period. 
4. Saline or water is nebulized to clean out the nebulizer head. 

This data collection procedure is performed identically for each subject.  The procedure results with a single 
measurement named “Main” placed for each subject.  This measurement can be summarized in the reports as a 
whole or subdivided into defined intervals as you choose.  A typical cough study report will subdivide the 
measurement into 2 subintervals, 10 minutes each, and reporting the following expression: [Cough:IsCought].Sum. 
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When you create your study, you will need to do the following: 

• Complete the Create Cough Study wizard  
• Select the Cough Algorithm Profile 

Everything else you can do as you go along.  For example: 

• Adding or modifying subject groups 
• Adding subject IDs 
• Adding or modifying reports 

Create Cough Study Wizard 

To create a cough study, find the FinePointe™ button under the Create Study Options on the Laboratory view. 

 

Figure 13.  The Laboratory page in FinePointe™ Review.  The Create Study button is indicated by the red oval. 
 

Select Create Study from the available studies you can create.  This will launch the Create Cough Study wizard. 
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Figure 14. The first page of the Create Cough Study wizard. 
 

On the first page of the wizard, you need to specify a unique study name and the species you intend to acquire.  
You can choose between rat, guinea pig, hamster and mouse.   

 

Finally, you can enter the number of subdivisions you want in your first report.   This value can be changed later 
and only applies to the first report which is created automatically when you create the study. 

 

Click Next. 
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Figure 15. The second page of the Create Cough Study Wizard. 
 

The second page of the wizard allows you to provide some descriptive information.  This content is optional and 
can be edited later.   

 

Click Next. 
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Figure 16. The third page of the Create Cough Study wizard. 
 

The third page of the wizard allows you to tell FinePointe™ what parameter or expression you want summarized in 
your initial report.  This information can be changed later. 

 

To create the parameter, click the New Parameter button: 

 

Figure 17. The yellow oval highlights the New Parameter button that you need to click to specify the 
summarization expression. 
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This button will present the Parameter Builder form. 

 

Figure 18.  This shows the parameter builder form. 
 

The Parameter Builder form has 2 tabs.  The Quick Builder tab can be used for most reports, but in this case, you 
will need to use the Advanced Builder tab.  Click on the Advanced Builder tab (as highlighted in  Figure 18).   

Next, fill in the Expression Name field.  In the example above, “CCnt” is specified. 

 

Finally specify the expression in the large expression edit box.  In the example above, the following expression is 
specified: “[Cough:IsCough].Sum”. 
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After you specify that, if you did so without any errors, the Validity of Expression should indicate Valid as it does 
above.  Otherwise, it will describe the problem which you can use to determine what the computer does not 
understand. 

 

Click OK. 

The wizard will return you to the third page of the wizard. 

 

Click Next. 

 

Figure 19.  The final page of the Create Cough Study wizard. 
 

On the final page of the wizard, you can specify parameters that will help you acquire data in a uniform way.   

All these parameters can be changed later, but it is a good idea to settle on their values before you begin acquiring 
data for the first subject in the study.   
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The Acclimation Period defines the amount of data to record while the subject is getting used to its surroundings 
in the plethysmograph.  This period can be manually ended as you wish during data collection.  Any period 
between 5 minutes and 20 minutes is recommended. 

 

The Response Time is probably the most important parameter you set up here.  This duration defines how long to 
record the data for once you begin nebulizing the irritant.  For guinea pig, a 20-minute recording is typical. 

The Aerosol Volume tells the system the volume of irritant you will load into the nebulizer head prior to running.  
This value is important when you are using this system with the FinePointe™ WBP controller or the QT interface 
and nebulizers.  But it is not used with the legacy nebulization apparatus.  When using this with the FinePointe™ 
WBP controller or the QT interface, you should probably add a little more material than you specify here since you 
want the nebulization to continue throughout the Response period. 

Delivery Duration specifies how long to nebulize for.  Some data collection procedures may require that 
nebulization of irritant only takes place during the first part of the measurement period.  Here you can specify a 
duration less than the Response Time if you want part of the measurement to be taken without the presence of 
the irritant. 

Click Finish. 

FinePointe™ will create and open your new cough study. 

Selecting Cough Algorithm Profile 

Next you need to select a cough algorithm profile.  It is important that this is done before you begin acquiring data.  
The profile you select determines the sensitivity that the system applies based on the expected size of the animal, 
and it also determines how you want to treat multi-cough events (see Multi-cough Event below).   

Sometimes a cough does not occur as a single cough, but instead could be a series of coughs rapidly following one 
after another (a multi-cough event).  You may want to treat the whole event as a single cough.  Or you may want 
to count them each separately.   

The following are the profiles you can choose from: 

Species Profile Name Weight Range Multi Cough Treatment 
Guinea Pig or 
Rat 

Normal, Each 200g-400g Each multi-cough event is treated as a 
single cough. 

Guinea Pig or 
Rat 

Normal, Multiple 200g-400g Each cough in a multi-cough event is 
treated as its own cough.  But the full 
cough criteria are only applied to the first 
cough.  Subsequent coughs only need to 
meet threshold conditions. 

Guinea Pig or 
Rat 

Normal, Single 200g-400g Each cough in a multi-cough event is 
treated and counted independently.  The 
full cough criteria are applied to each 
cough within the event. 

Guinea Pig or 
Rat 

Large, Each 350g-700g Each multi-cough event is treated as a 
single cough. 
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Species Profile Name Weight Range Multi Cough Treatment 
Guinea Pig or 
Rat 

Large, Multiple 350g-700g Each cough in a multi-cough event is 
treated as its own cough.  But the full 
cough criteria are only applied to the first 
cough.  Subsequent coughs only need to 
meet threshold conditions. 

Guinea Pig or 
Rat 

Large, Single 350g-700g Each cough in a multi-cough event is 
treated and counted independently.  The 
full cough criteria are applied to each 
cough within the event. 

Mouse Normal, Each <30g Each multi-cough event is treated as a 
single cough. 

Mouse Normal, Multiple <30g Each cough in a multi-cough event is 
treated as its own cough.  The full cough 
criteria are only applied to the first 
cough.  Subsequent coughs only need to 
meet threshold conditions. 

 

To select the profile, go to the main study page of your cough study.  Find the Acquisition Algorithm Settings 
button on the top button menu. 

 

 

Figure 20.  This highlights the Acquisition Algorithm Settings button that appears on the main study page.  The 
button is shown within the yellow oval. 
 

Click on the Acquisition Algorithm Settings button. The Algorithm Setting form is presented.  On this form you can 
select how you want the cough data logged and on a separate tab, how the WBP data is logged. 
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Figure 21.  This is an image of the Algorithm Settings form.  The Cough analysis tab is selected.  If you select the 
WBP tab, then you can configure the algorithm settings for the WBP respiratory analysis. 
 

Refer to table above to determine which algorithm profile best suits your needs.   

 

Creating Groups 

FinePointe™ provides a powerful reporting engine which allows you to get grouped reports which are complete 
enough for many users reporting needs.  In addition to saving time and eliminating mistakes, making use of the 
built-in reporting features provides you with fully annotated and traceable dataset. 

One major part of the reporting features is the facility to create subject groups.  You can create as many groups as 
you want and have as many subjects in each group as you want.  Also, subjects can belong to multiple groups, and 
you can add and remove subjects from groups at any time.  When you define a report, you specify 3 key pieces of 
information: the groups to include in the report, the parameters (or parameter expressions) to summarize, and the 
measurements to use to select the data.   

This section describes setting up groups.  Keep in mind that you can set up these groups at any time, whether 
you’ve not started collecting your data, or even after all your data has been collected. 

From the main study page, click the Manage Groups and Subjects button.  It is shown in Figure 22. 
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Figure 22.  This shows the Manage Groups and Subjects button on the main study page. 
 

The Groups and Subjects page is presented.  This page shows you the groups and subjects that are currently 
defined in your study database.   

 

 

Figure 23.  This shows the Groups and Subjects page. 
 

From this page you can edit the subjects and groups which are already defined, or you can create new ones.  Keep 
in mind that you can also create subjects on-the-fly as you acquire your data, so doing it here is not required. 

 

To create a new group, click the New Group button located under New Items at the top of the page. 
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Figure 24.  This shows the dialog box presented when you click the New Group button.  Shown here the subjects 
list is empty because no subjects have been defined in the study yet.  As you define the subjects you can add 
them to this group and other groups as necessary. 
 

A dialog box like the one show in Figure 24 is presented. The Group ID is a text identifier you will use to refer to 
this group in your reports.  Choose an ID which is meaningful to you and unique from all the other groups.   
Description is optional. 

 

The list on the right shows all the subjects currently defined in your study.  In the example above, this list is empty 
since no subjects are currently defined.  If subjects were present, you could place a check by each subject you 
wanted to be part of this group. 

 

There is also a list of reports located under the description.  You can place a check by the reports that you want to 
include this group.  You can change this also by editing the report. 

 

Click OK.  The dialog box will disappear, and the new group will be created. 

If a group is already defined, you can click on it in the Groups and Subjects page and the list on the right half of the 
page will be populated with the subjects that are members of that group.  You can quickly change the membership 
by selecting the group and clicking the + button above the list on the right. 
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Figure 25.  The Groups and Subjects page.  Shown here, GRP 01 is selected, and the list on the right shows the 
subjects which are members of that group (there are none). The + button is highlighted.  Click this to change the 
membership of the group. 
 

When you click the + button, a dialog box is presented that allows you to change the membership. 
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Figure 26.  This shows the dialog box that allows you to change the subjects which are members of the group.  
Place a check by each subject which should be part of the group. 
 

Select the subjects and click the OK button. 
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Creating Reports 

To create a cough report, begin navigating to the main study page of your cough study, and click the Create Report 
button located at the top of the page. This will launch the Create Report dropdown. 

 

 

Figure 27. The first page of the Create Report wizard. 
 

Report Type Description 
Response Report (Dose) Summarizes one or two expressions for multiple measurements and multiple 

groups.   
Time Course Summarizes an expression for multiple measurements, each subdivided into 

fixed intervals (specified by you) and multiple groups. 
Time Course- 2 Parameter Summarizes two expressions for multiple measurements, each subdivided 

into fixed intervals (specified by you) and multiple groups. 
Parameter Summary Summarizes many expressions for a single measurement and multiple 

groups.  The processing of this report is the same as that of Dose Response 
but permits many expressions. 

 

These reports are described in detail in the WBP Application Manual.  Below is an example of how to create a Time 
Course Report. 

 

The first page of the wizard asks you to provide a name of the report, and optional description, and indicate the 
number of divisions to report in the response interval.  The report name must be unique within the study.  

The number of divisions to report allows you to have the recorded interval following the irritant to be subdivided 
into equal time intervals.  If you specified a 20-minute response duration in the task sequence configuration, and 2 
divisions, then the report will summarize the data as 2 consecutive 10-minute intervals.   

 

Click Next. 
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On the second page of the wizard, you specify the parameter or the parameter expression you want summarized. 

 

 

Figure 28.  The second page of the Create Time Course  Report wizard.  Here you can specify one parameter 
expression to summarize. 
 

Click New Parameter to define your parameter.  This button presents a dialog box which will help you build the 
parameter expression you want. 

 

Figure 29.  This is an image of the Parameter Builder which is presented when you click the New Parameter 
button. 
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The parameter builder has two tabs: Quick Builder and Advanced Builder.  The Quick Builder tab allow you to make 
a couple simple selections and it will create the expression for you.  This can be used for many common 
expressions, especially expressions which are based on one parameter.   

The Advanced builder allows you to build more complex algebraic combinations of parameters and functions. 

Using the Quick Builder, you can select one parameter from the available parameters derived on the site and one 
of the common functions to compute on that parameter.  For example, if you wanted the average respiratory rate, 
click the “f” parameter under WBP and the Average function. 

Once you are satisfied with your selection, click OK.  

You will return to the Configure Parameters wizard page.  Click Next. 

 

Figure 30. The final page of the Create Time Course Report wizard.  This page allows you to select which groups 
to summarize for this report. 
 

On the final page of the Create Time Course Report wizard, you can select the groups to summarize in the report.  
All Subjects is a built-in group which automatically holds all subjects.   
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Click Finish.  When you click finish, FinePointe™ creates the report and computes the results.   

You can change all these settings at any time by opening the report and clicking the Modify Report Settings 
button.  This button will launch this same wizard again. 

Calibrating 

Once your hardware configuration and study are created, you will need to calibrate before you can begin to 
acquire data.  To do so, return to the laboratory page. 

 

 

Figure 31. This shows what your Laboratory page may look like once you have created a cough study and a 
hardware configuration.  Study databases are represented as notebooks on the left of the page, and Stations 
(hardware configurations) are presented on the right. 
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When you hover the mouse over the station, a button bar slides into view as show in the next figure. 

 

Figure 32.  This shows the buttons on the bottom of the station which slide into view when you hover the mouse 
over it. 
Click on the amber wrench button (labeled Calibrate) to launch the calibration page. 

 

Figure 33.  This shows the calibrate page you use to calibrate the Box Flow signals. 
 

Click the Calibrate button to launch the calibration wizard for each Box Flow signal.  The Calibrate Button launches 
a calibration wizard which steps you through the steps necessary to calibrate the signal. 
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Acquiring Data 

One of the greatest benefits of FinePointe™ software is the integration with reporting.  FinePointe™ is aware of 
the types of reports you want to produce, so it is able to assist you with data acquisition in a way unmatched by 
any other system available.   

In assisting your data collection, it helps ensure consistency of the data, freeing your hands up and your mind from 
details so that you can be more aware of other aspects of the experiment that may also impact consistency.  As 
you acquire data, FinePointe™ automatically annotates the data so that you have a complete documented record 
of what took place and it also places measurements which will be used for your reports.   

Once you are done acquiring data for a subject, typically you only need to add that subject to its associated groups 
(if you have not already done so by creating subjects and groups ahead of time).  FinePointe™ automatically 
imports the new data into your study and updates your reports. 

In addition to all this automation, FinePointe™ allows you to annotate your data yourself, or operate totally 
manually, if you need to for some reason.  FinePointe™ Station is designed to offer automation where it helps and 
stay out of your way if you do not need it. 

To acquire data, you will do the following: 

• Launch FinePointe™ Station for the study where you will store the data 
• Assign subject IDs to sites 
• If running for the first time, you will set up your views. 
• Acquire your data using the Task Sequence which walks you through your data collection procedure. 
• End the session, which starts the upload to the database. 

Launching FinePointe™ Station 

To acquire data, launch FinePointe™ Station for the study on the station you want to run on.  There are 2 ways to 
do this, and they are both functionally equivalent. 

To launch FinePointe™ Station using the “Drag-and-Drop” method, navigate to the laboratory page showing both 
the study you want to acquire data into and the Station configuration on the same view.  Drag the study you want 
to store the data into and drop it on the station you want to acquire with. Figure 34 illustrates how this is done. 
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Figure 34.  This illustrates how to launch FinePointe™ Station using the Drag-and-Drop method.  Simply use the 
mouse to select and drag the study and drop it on the Station configuration. 
 

An alternate way to launch FinePointe™ Station is to open the study you want to acquire to and select the Launch 
Station button on the command bar of the Study page.  Only station configurations which are compatible with the 
study are listed. 

 

 

Figure 35.  This illustrates where you can find the Launch Station button on the main Study page. 
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Assigning Subject IDs 

After you launch acquisition, FinePointe™ Station opens the Assign Subject IDs page.  In this page you identify the 
subjects that you place in each site of the station configuration.  The subject ID can be almost any nonblank text. 

 

Figure 36.  This shows the Assign Subject IDs page for a 4-site guinea pig apparatus.  The area marked with the 
yellow box indicates where you need to assign the subject IDs. 
 

In Figure 36 the yellow box marks the area where you need to assign the subject IDs.  The list below labeled 
“Subjects Without Data” are subject IDs that you have already created in your study but have not yet acquired data 
for them.  If you have something in this list, then you created the subject IDs in the Groups and Subjects Page 
described earlier in this document.  The list labeled “Subjects With Data” are subject IDs that already exist in your 
study, but there are already recordings in the study associated with them.  

You can use the subject IDs in either of these bottom lists by dragging them and dropping them on the appropriate 
site.   

Alternatively, you can create new subject IDs by typing them in the Subject ID text box above the site list and 
clicking Create Subject. 
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If you do not have any specific subject designation but want to make sure each subject ID is new and unique, you 
can type a subject ID root name into the Subject ID text box and click Bulk Add.  This will use the text you specify in 
the Subject ID text box and append a number onto it for each subject it creates. 

You do not need to assign a subject ID to each site.  Only sites with assigned subject IDs are acquired, so you can 
use this as a way of running with fewer sites if you choose.   

 

Figure 37.  This shows the Assign Subjects to Sites form with only subject IDs assigned to Site 1 and Site 2.  So, if 
you click Finish, only Site 1 and Site 2 will be acquired. Site 3 and Site 4 will not. 
 

After you have assigned subject IDs to the sites you will run, click the Finish button.  FinePointe™ Station will begin 
acquiring live data.   

Configuring Views for the First Time 

If you are running for the first time, you may need to arrange the view settings.  While you should feel free to pick 
an arrangement that suites your needs best, the following is a recommended arrangement for cough applications. 

Select Charts->Signals on the main menu on the summary display. 
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Figure 38.  This picture shows you where to find the Chart->Signals menu. 
 

The Signals Options form is presented.  Figure 39 shows recommendations for guinea pig: 

 

Figure 39. Recommended Signal View options for guinea pig acquisitions. 
 

Figure 40 shows recommendations for mouse: 

 

Figure 40. Recommended Signal View options for mouse acquisitions. 
 

Next select Chart->Expressions from the main menu.  This allows you to configure which parameters are shown on 
the dashboard and plotted on the trend chart. See Figure 41 and Figure 42 for recommended settings. You can 
change these settings at any time. 
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Figure 41.  This shows a recommended Expressions view setup for guinea pig. 
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Figure 42. This shows a recommended Expressions view setup for mouse. 
FinePointe™ Station provides 2 kinds of views: summary view (only 1), and detail view.  The summary view shows 
you a summary of all your sites on a single page.  The detail view shows full detail and content for a single site.  
With a 2-site station configuration, you have a possibility of arranging 3 windows on your computer: 1 summary 
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window, and 2 detail windows.  They can be present all at once or you can choose to have only some displayed at a 
time. 

The View menu located on the summary view allows you to select from many predefined arrangements.  You can 
even design and save your own if you choose. 

 

 

Figure 43.  This shows the view menu for a computer with 2 monitors. 
 

FinePointe™ Station populates the View menu content by looking at how many monitors you have installed on 
your computer.  It is easiest to choose one of the layouts provided, or you can click the Design New View button to 
explore creating a layout of your own. 

Walking Through the Task Sequence 

FinePointe™ Station provides a task sequence that allows FinePointe™ to walk through your data collection tasks 
with you.  FinePointe™ allows each site to be acquired independently.  So each site can be at a different point in 
the data collection task sequence at any given time.  However, if the sites are not actually independent (e.g. they 
all share a nebulizer), then you will have to run all the sites together, synchronized.   

On the summary view and on each detail view, FinePointe™ provides a task sequence control console.  This 
console shows you: 

• where it is in the current task sequence (current task). 
• what, if anything, you can do, and a button (Play button) to say you’ve done it. 
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• if it is in the process of executing something, what is the progress. 

If you are using FinePointe™ WBP controllers, the first two items are presented on the associated site console on 
the FinePointe™ WBP console bar. 

 

 

Figure 44. An example FinePointe™ Station console. 
 

In the example shown in Figure 44 the console says “Hit  to Begin…”  This message tells you what you can do 
now.  The Current Task is indicated as “Start of Experiment”.  If you click on that text, a dialog box opens showing 
you the complete task sequence. You can click Cancel to close the window. 

 

 

Figure 45.  The complete task sequence for a cough study. 
 

FinePointe™ executes the task sequence from the first step to the last step.  By reading this, you can see what is 
needed to acquire data for this study.  In this example, FinePointe™ waits for you to begin.  At this point, you 
should make sure the apparatus is properly setup, and the data being acquired from the animals looks good. 

When you are ready, click the  (play) button.  FinePointe™ starts the recording and begins timing the acclimation 
period.  You can interrupt the acclimation period by pressing the  button again.  Next FinePointe™ waits again 
for you to deliver the first challenge (PBS). 

Current Task Play button 
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Once you do, press the  button again, and FinePointe™ delivers the aerosol and times the measurement interval.  
When done, it waits for you to load the nebulizer again with the next challenge concentration. 

 

The arrow indicates the current task.  You can select a task and click Apply if you want to skip to that task, but that 
should only be necessary in unusual circumstances. 

If you need to run all the sites together (i.e. due to a shared nebulizer), you can use the F12 button to hit  on all 
the Sites at once.  Make sure the summary window is selected, otherwise the F12 button press may end up going 
to another window (and FinePointe™ will not be aware of it). 

End the session 

Once you have completed the data collection task sequence, select the File->End Session menu on the summary 
window.  The End Session wizard is presented. 

 

 

Figure 46.  The first page of the End Session wizard.  Select the subjects you want to save to the database.  By 
default, they are all selected. 
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Usually, you will not do anything here since the default is the save all the data.  The first page of the wizard does 
give you a chance to reject data here.  If you do, it will not up upload into the study database. 

 

Click Next.  

 

 

Figure 47. The final page of the End Session wizard.  This page simply confirms what you selected on the first 
page. 
 

The final page of the wizard confirms what you selected on the first page.  If satisfied, click Finish.  Otherwise, click 
Cancel or Back. 

If you click Finish, FinePointe™ will begin the process of importing the data into the study.  This can take a few 
minutes, but you can launch FinePointe™ Station again (even before the data is fully imported) and begin data 
collection of the next subject. 
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Cough Detection 

The cough detection algorithm is different depending on the species.  Broadly speaking, both algorithms first 
detect an event and then apply criteria to decide if the event is a cough.  If it is, the IsCough parameter is set to a 
non-zero value.  For guinea pig, it is set to a 1 for a cough, and 0 for a non-cough event. Patented fuzzy logic 
criteria that are applied to a detected event to determine if the event is a cough.  For mouse, the IsCough 
parameter is coded to a value which indicates the type of cough event that occurred.   The mouse algorithm uses a 
set of fixed properties to decide. 

 

Multi-cough Event 

A multi-cough event occurs when the animal coughs in rapid succession.  You may want all the coughs within such 
an event combined and reported as a single cough, or you may want to count each one individually.  An example of 
what a multi-cough event might look like on the box flow signal is shown in in Figure 48.  

 

In addition, when such an event occurs, the coughs that occur after the first may not be fully formed, and so if the 
cough criteria is applied to each, it is possible the second event may not get counted as a cough. 

 

To deal with these issues associated with multi-cough events, you need to select how FinePointe™ handles these 
events.  FinePointe™ provides 3 possible modes for handing this: 

 

Multi-cough Mode Multi-Cough Treatment 
Each Each multi-cough event is treated as a single cough. 
Multiple Each cough in a multi-cough event is treated as its own cough.  But, the full cough 

criteria are only applied to the first cough.  Subsequent coughs only need to meet 
threshold conditions. 

Single Each cough in a multi-cough event is treated and counted independently.  The full 
cough criteria are applied to each cough within the event. 
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Multi-cough Event on Box Flow 

 

Figure 48.  An example of a multi-cough event. 

Guinea Pig and Rat Analysis 

Analysis of the box flow signal begins with filters applied to the box flow signal to remove any DC drift.  A high pass 
filter with a very low cutoff is used.  The filtered box flow signal is then passed into a state machine which looks for 
the box flow to exceed a positive threshold, and then fall below a separate negative threshold within a certain 
time.  If that is found, then an event is identified, and it waits until the box flow returns to zero to find the end of 
the event.  The main parameter collected during this processing is the DHCP parameter.  This parameter is based 
on the last positive threshold crossing and the last negative threshold crossing (since it is possible that each 
threshold can have multiple crossings in a single event). 

The following is the logic used to determine if an event is a cough: 

To Compute IsCough, first we calculate IsCoughfuzzy using the following formula: 
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Where: 

V2 is the value of V2. 
Weight is the weight of the animal (as entered in the algorithm settings). 
Cv2 is a value which defines the “crispness” of the V2 contribution. 
Tv2 is a value which defines the “threshold” of the V2 contribution. 
Iv2 is a value which defines the “importance” of the V2 contribution. 
CDHPC is a value which defines the “crispness” of the DHPC contribution. 
TDHPC is a value which defines the “threshold” of the DHPC contribution. 

http://www.datasci.com/


   
 

Page 46 
Cough Site Application Manual • Publication 0011580-001 REV 04 • www.datasci.com  ©2023 Data Sciences International 
 

IDHPC is a value which defines the “importance” of the DHPC contribution. 
 

Then additional values are used along with conditions to determine the value of IsCough: 

Pessimism  is a number (from 0 to 1) which is used overall to decide if it is a cough 
Multi-event-rule is an enumerator used to decide how to handle events which occur close together. 
previousIsCough is 1 if the last reported event is a cough. 
 
The following logic is applied: 

If (Multi-event-rule = 0) or (IsCoughfuzzy < Pessimism) then 
 IsCough = 0 
else 
 IsCough = 1 

If (Multi-event-rule = 1) and (previousIsCough = 1) then 
 IsCough = 1 
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Parameters Reported for Guinea Pig 

Name Description Units 
Vinsp Not defined for guinea pig or rat n/a 
V2 The volume due to compression mL 
F2 Not defined for guinea pig or rat n/a 
dFdt Not defined for guinea pig or rat n/a 
DHPC Delta Half Peak Crossing.  A time index which reflects the time it takes 

to transition from the compression phase to the expulsive phase. 
Samples (5ms 
interval) 

IsCough A value of 1 or 0.  When value is 1, then the event is judged to be a 
cough.  Otherwise it is not. 

 

CCnt The number of coughs since the last analyzer reset.  
 

Mouse Analysis 

Analysis of the box flow signal begins with filters applied the box flow signal to remove any DC offset.  The DC-
corrected box flow signal is then differentiated, and the resulting slope and corrected box flow signals are passed 
into a state machine to identify cough events. 

The state machine looks for events where the box flow first exceeds a threshold on the expiratory side (a likely 
compressive phase) followed by the box flow slope falling below a negative threshold (a likely transition to 
expulsive phase). If these events are detected, and the box flow returns to zero within a certain period of time, 
then it is an event considered for the cough criteria. 

Parameters Reported for Mouse 

Name Description Units 
Vinsp The volume inspired immediately before the event mL 
V2 The volume due to compression mL 
F2 The box flow as the compression phase begins to transition to 

expulsive phase 
mL/sec 

dFdt The maximum rate of change (falling) of box flow when transitioning 
from the compressive phase to the expulsive phase. 

mL/sec2 

DHPC Not defined for mouse n/a 
IsCough A coded value which scores the cough event.  If zero, it is not a cough, 

otherwise it is a cough. 
 

CCnt The number of coughs since the last analyzer reset.  

 

  

http://www.datasci.com/


   
 

Page 48 
Cough Site Application Manual • Publication 0011580-001 REV 04 • www.datasci.com  ©2023 Data Sciences International 
 

Spike Detection 

FinePointe™ version 2.9 introduced an additional feature to the Cough analyzer.  There is a new tab available in 
the Algorithm Settings and Data Table labeled “Spike”. This Spike Detection feature is for researchers who want an 
alternative to the FinePointe™ cough algorithm, so that they can count simple spikes in the signal rather than 
requiring the compressive/expulsive phases of a true Cough.  In this instance a spike is simply an elevated period of 
flow determined by thresholds, which may or may not correlate to a physiological “cough”.   

FinePointe™ will detect any positive spikes in the flow signal and mark them as such.  This is run in parallel with the 
existing cough algorithm. 

 

There are only two thresholds that need be set to detect a spike in the flow signal:  a Minimum Threshold and 
Maximum Threshold.  These thresholds are evaluated as an additional flow above the bias flow setpoint. 

The Minimum Threshold is the minimum flow above the bias flow for a spike to be considered. 

The Maximum Threshold is the maximum peak above the bias flow for a spike; if the spike goes above this 
threshold it is considered noise and will not be counted as a spike. 

These thresholds should be determined by the end user after an assessment of their data, the flow patterns, and 
what values would make the most sense.   

The Spike tab in the data table gives two new parameters:  IsSpike and SCnt (Spike Count).  These are functionally 
identical to the IsCough and CCnt parameters in the Cough analyzer discussed on the previous page.   
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Some Spikes will also be counted as Coughs and some Coughs as Spikes; the two analyzers are run completely 
separately from each other so their results may naturally overlap.     
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Contact Information 

We are available to help you with your questions and concerns. Should you hit a roadblock or need some additional 
training, please feel free to visit DSI Support Center at https://support.datasci.com to find articles and helpful information 
in our knowledge base, Chat with an agent, or setup time to receive one-on-one consultation.  We are happy to help! 

Data Sciences International (DSI)  
119 14th Street NW 
New Brighton, MN 55112 
 
DSI Technical Support—North America 
Email: Support@datasci.com 
 

DSI Technical Support—Europe 
Email: Europe-support@datasci.com 
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